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ABSTRACT
Atherosclerosis is a chronic inflammatory disease the progression of which is mediated,
in large part, by the balance of macrophages within the lesions. The progression of
atherosclerosis is associated with an increase in infiltrating inflammatory macrophages (also
called M1 macrophages) and a decrease in tissue-resident macrophages linked to healing and cell
clearance (also called M2 macrophages). Ron is a receptor tyrosine kinase expressed on tissueresident macrophages. In vitro and in vivo, Ron promotes the development of macrophages linked
to wound repair and apoptotic cell clearance and inhibits the activation of inflammatory
macrophages. Therefore, we hypothesized that Ron would play a protective role in the
progression of atherosclerosis. In order to test this hypothesis, we examined the composition of
atherosclerotic plaques formed in the aortic roots of eighteen-week-old mice in the presence and
absence of Ron. We examined the deposition of collagen, the percentage of apoptotic cells, and
the extent of necrosis using trichrome collagen staining and TUNEL assay. The results showed a
significantly greater percentage of apoptotic cells present in plaques of mice in the presence of
Ron, associated with a trend towards decreased necrosis in these plaques. However, we did not
observe a significant difference in the amount of collagen deposition in the plaques from wildtype and Ron knockout animals. These data suggest that Ron may play a protective role in the
progression of lesion formation, but may not protect against lesion rupture caused by decreased
collagen in the fibrous cap.
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Chapter 1 : Introduction

Atherosclerosis
Cardiovascular disease, including coronary artery disease and cerebrovascular disease, is
a major cause of mortality facing the world today2. Throughout the past few decades, our
understanding of atherosclerosis as a disease has changed dramatically. Prior to these advances it
was thought that atherosclerosis was a passive disease affecting lipid storage2. Today,
atherosclerosis is characterized as a chronic inflammatory condition in which fatty streaks and
plaque lesions form in the subendothelial portion of the blood vessels3. When the fatty lesions
continue to advance they form thick fibrous caps and the interior begins to form necrotic
tissue1,25,26. With continued progression of this necrotic area, there is an increased risk of rupture
of these plaques, which can cause hemorrhaging and death1,25. While there is much research
regarding various aspects of this chronic disease, there is a distinct lack of advancement toward
therapies able to target the problems1.
Atherosclerosis progresses in stages beginning with thickening of the intima infiltration
of macrophage foam cells at the luminal surface1,27. As the lesions progress they form a necrotic
core collecting cell debris along with a developing fibrous cap surrounding the area1,25. This cap
becomes visually distinct as the lesion advances and starts to thin causing greater danger that the
plaque will rupture1,25. It has been shown that, in these necrotic cores with thinning fibrous caps
are many macrophages and T cells1,28. The macrophages in these advanced lesions play a central
role in the development of atherosclerosis.
The connection between inflammation and atherosclerosis was a critical change in its
study both in the way we look at risk factors as well as mechanisms and future treatments3.
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Inflammation participates in each stage of plaque progression3. Normal endothelium will not
bind well with blood leukocytes however, in an early stage fatty streak when the endothelium
starts to become inflamed it will express adhesion molecules3. As the lesion grows, T cells will
join macrophages present in the forming lesion3. This can then promote induction of enzymes
which function to degrade collagen found in the plaque as it responds to the inflammation3. In
more advanced lesions, inhibition of collagen synthesis can take place, weakening the fibrous
cap, due to the presence of inflammatory mediators3. This is supported by studies showing that
patients diagnosed with chronic inflammatory diseases have a significantly higher risk of
developing cardiovascular disease2.
There is increasing evidence demonstrating a connection between inflammation and other
health conditions that are widely considered triggers for such events3. These include diabetes,
hypertension, and obesity3. Of much interest is the increasing evidence that inflammation could
participate in hypertension, which would link it to atherosclerosis by way of pathophysiology3.
While the composition of these fatty plaques is understood on a general level, but a more in depth
look could aid in development of therapeutic techniques in the future. It is known that these
plaques contain apoptotic cells, necrotic regions, cell debris, and cholesterol crystals3. Also
present in both fatty streaks and established lesions are macrophages5. A better understanding of
the role of macrophages in atherosclerosis may help to develop novel therapeutic techniques5.

Macrophages
Macrophages are known to play a role in innate and adaptive immunity and are present
throughout the body5. They are key players in metabolic inflammation and as such, play an
important role in the progression of atherosclerosis6,19. Studies show that there are two extremes,
or types, of macrophages19. This includes classically activated macrophages, often termed M1, at
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one end of the spectrum and alternatively activated macrophages, termed M2, at the other19. The
M1 type macrophages promote proinflammatory processes5,29. The M2 type, conversely, promote
repair and resolution5,29. The presence of these types of macrophages in atherosclerotic lesions is
of much interest in the field in recent years5.
There has been a lot of research characterizing how changes in macrophage gene
expression may affect the concentration of M1 or M2 macrophages present in atherosclerosis.
Recent studies have shown arginase 1 (Arg 1) is a marker for M2 macrophages19,21. Arg 1
hydrolyzes L-arginine into urea which leads to the formation of polyamines as well as Lproline19,21. As the M2 macrophages are categorized in repair and resolution, so are the
polyamines and L-proline19,21. Inflammatory M1 macrophages, on the other hand, express
inducible nitric oxide synthase (iNOS) which competes for L-arginine to produce nitric oxide
which is cytotoxic. Together these changes in the metabolism of L-arginine can affect the
progression of atherosclerosis21.
Arg 1 expression is induced in M2 macrophages in a Stat6-dependent manner by the Th2
cytokines, IL-4 and IL-13. However, recent studies have shown that Arg 1 expression is
promoted through a Stat6-independent mechanism by the receptor tyrosine kinase, Ron22. In
primary macrophages treated with macrophage stimulating protein, the ligand for Ron, MAPK is
activated enhancing binding of AP-1 to the Arg 1 promotor22. Tumor-associated macrophages
(TAMs) exhibit an M2 phenotype and promote tumor growth. In mice deficient of the Ron gene,
the expression of Arg 1 is significantly reduced in tumor-associated macrophages, associated with
decreased tumor growth22. This relationship between the Ron receptor and M2 macrophage
activation, as measured by Arg 1 expression, suggests that Ron might also regulate the
progression of atherosclerosis.
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Ron Receptor Tyrosine Kinase
Ron is a receptor tyrosine kinase, and its ligand is macrophage-stimulating protein
(MSP)20. MSP is primarily produced in the liver and circulates in an inactive form. Upon
entering inflamed tissues, MSP becomes proteolytically cleaved and activated. Ron is a member
of the MET gene family and has been shown to be involved in the regulation of immune
responses by regulating macrophage activation20. In the immune system, Ron expressed in
certain types of tissue-resident macrophages including Kupffer cells in the liver, mesangial cells
in the kidney, microglia in the brain, marginal zone macrophages in the spleen, and resident
peritoneal macrophages23. The specificity of its expression within the immune system suggests
that it is tightly regulated within this population of cells23.
Several studies have shown that Ron expression is crucial in limiting inflammatory
responses23. Ron knockout mice are more susceptible to septic shock and acetaminophen-induced
liver damage, associated with increased iNOS expression and increased pro-inflammatory
cytokine production. Changes in the balance of M1 and M2 macrophages in the presence and
absence of Ron may account for the differences in susceptibility to inflammatory disease23. A
better understanding of this connection and how it relates to chronic inflammatory diseases, such
as atherosclerosis, will likely provide novel techniques to identify and treat such problems.

Hypothesis
Based on its ability to inhibit M1 macrophage activation and promote an M2 phenotype,
we hypothesized that the receptor tyrosine kinase Ron plays a protective role in the progression of
atherosclerosis. The focus of the research was to study the possible similarities and differences in
the composition of the atherosclerotic plaques between mice in the presence and absence of Ron.
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The approach was to determine whether the composition of atherosclerotic plaques found in the
aortic roots in ApoE knockout mice, which are predisposed to form atherosclerotic lesions on a
high cholesterol diet, were changed based on the presence or absence of the receptor tyrosine
kinase Ron.
Specifically, we hypothesized that a smaller percentage of the plaque area would be
stained for collagen presence in the mice that lacked the Ron receptor. We hypothesized that
there would be an increase in apoptotic cells present in the atherosclerotic plaques of the mice
lacking the Ron receptor gene. Finally, we hypothesized that the necrotic core area would be
greater in those mice lacking Ron.
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Chapter 2 : Materials and Methods

Mouse Models
Two genotypes of mice were used in the research. Apolipoprotein E knock out (ApoE-/-)
mice on the C57BL/6 background were purchased from Jackson Laboratory (Bar Harbor, ME).
The ApoE-/- mice are predisposed to form atherosclerotic lesions15. The other was a double gene
knock out (DKO) of the ApoE (ApoE-/-) gene and receptor tyrosine kinase Ron (Ron-/-). To obtain
the DKO genotype, ApoE-/- and Ron-/- mice were intercrossed. The Ron-/- mice were also on the
C57BL/6 background. A polymerase chain reaction confirmed the DKO genotype. All of the
mice were maintained and bred at the Pennsylvania State University animal facility following the
protocol approved by the Institutional Animal Care and Use Committee (IUCAC).
Mice were fed a high cholesterol diet composed of 60% calories from fat plus 1.25%
cholesterol (BioServ 6334) after being weaned at 5 weeks of age. The first 5 weeks all mice were
fed a normal chow diet. All mice were sacrificed per IUCAC protocols at 18 weeks, so they were
on the high cholesterol diet for a total of 13 weeks. The high cholesterol diet provided an
accelerated model of metabolic disorder in order to study atherosclerotic progression in the mice.
Both the single and double knockout mice were treated and analyzed equally throughout the
experiments.

Aortic Root Samples
At 18 weeks, mice were sacrificed by carbon dioxide inhalation following IUCAC
protocols. The hearts were isolated and snap frozen in optimal cutting temperature (OCT) media.
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The isolated hearts were stored at a temperature of -80°C. The frozen samples were sectioned to
expose and then collect 7µm thick sections form the aortic root area of the heart. The aortic root
sections were prepared using the Shandon Cryostat, with a sample thickness of 7μm. This
method was used as it kept the heart samples frozen and intact to allow for complete sections of
the area in question. The aortic root slices were placed on glass slides and completed sections
were stored at -80°C until the staining and analysis was to be completed

Trichrome Collagen Staining
The samples were sent for trichrome collagen staining to the Animal Diagnostic
Laboratory at the Pennsylvania State University. The stained samples were then imaged under a
microscope and the presence of collagen and necrotic area in the plaques were measured using
Image J software as described below in the analysis techniques section.

TUNEL Assay
The TUNEL assay, terminal deoxynucleotidyl transferase end labeling, is used to label
DNA strand breaks to identify cells that have begun to undergo apoptosis17. The TUNEL reaction
labels the DNA strand breaks by a polymerization of labeled nucleotides to free 3’-OH ends17.
The stained slides were analyzed using fluorescence microscopy to detect the apoptotic cells,
tagged with green fluorescence protein (GFP). The samples were also stained with DAPI, which
labeled the nuclei of the cells present in the section.
The assay procedure for cryopreserved sections involved multiple steps including
fixation, permeablization, labeling the reaction with the TUNEL reaction mixture, and finally
analysis of the samples using fluorescence microscopy. The In Situ Cell Death Detection Kit,

8
TMR Red, Version 11 was used for the assay. First, the tissue samples were fixed using the
fixation solution for a total of 20 minutes at +15-25°C. Then, the samples were washed with PBS
for 30 minutes. Next, the slides were placed in permeablization solution for 2 minutes completed
on ice to be kept between +2°C and +8°C.
The TUNEL reaction mixture was prepared and kept on ice until use. Two negative
controls and a positive control were included. The two negative controls had 2 samples incubated
each in 50µl of label solution. No TUNEL reaction mixture was used on the negative controls.
The positive control used a sample which was incubated in recombinant DNase I for 10 minutes
between +15°C and +25°C. This was done to induce DNA strand breaks before the labeling
procedure for the positive control.
The labeling procedure was then conducted for each sample. First, each slide was rinsed
twice with PBS and the area around the sample was dried. Next, 50µl of the TUNEL reaction
mixture was placed on each sample, excluding the negative control sample. The samples were
covered with a coverslip for the following incubation. The slides were then incubated for 60
minutes at +37°C in the dark. After 60 minutes, the slides were rinsed 3 times with PBS. At this
time the staining procedure was completed and the samples were then viewed and imaged by
fluorescence microscopy.

Analysis Techniques
The analysis of the sample images for both the collagen staining and the TUNEL assay
were done using Image J software. To begin with the trichrome collagen stain samples, the total
plaque area on each image was isolated and the isolated plaque image was then used in the Image
J analysis in order to measure collagen stained area, the total plaque area, and the necrotic area.
Each image was taken as a 14.16in.X10.67in (1360X1040 pixels) image at 50x magnification.
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For each sample the isolated plaque image, still 1360X1040 pixels and 14.16in.X10.67in., was
opened in Image J and first converted to a grayscale 8-bit image (Image → Type → 8-bit). Next,
the measurements were set (Set measurements → check “area” and “limit to threshold”). The
scale was set to 96.012 pixels/inch. This measurement was used because we were not able to
image the samples with a scale bar on the image and this would accurately measure the area since
all pictures were taken with the same pixel dimensions and at the same magnification. Note that
these measurements were used to look at the average percent of the total area the collagen and
later necrotic area composed.
This threshold was adjusted to highlight all of the collagen stained area for measurement
(Image → Adjust → Threshold) and the top and bottom threshold slide bars were set to 0 and
150, respectively. The collagen area measurement was then taken (Analyze → Measure) and the
resulting area measurement was recorded (in inches2, note this is the area based on its size in the
image). Then, the threshold highlighted area was adjusted where the top and bottom slide bars
were set to 0 and 248, respectively to cover the total plaque area. The total plaque area was
measured (Analyze → Measure) and recorded. Next, the image colors were inverted to allow for
threshold measurement of the necrotic area (Edit → Invert). As before, the threshold was
adjusted to measure the necrotic area with the top and bottom slide bars set to 145 and 249
respectively. The necrotic plaque area was measured (Analyze → Measure) and recorded. The
percent collagen area of the plaque was calculated [(collagen area/total plaque area)*100] and the
percent necrotic area was calculated [(necrotic area/total plaque area)*100] and both were
recorded. These steps were repeated for each collagen staining sample.
Image J was also used to complete the cell counts for the GFP and DAPI stained cells in
the plaque area samples of the TUNEL assay. Before each sample image could be analyzed in
Image J, the color was inverted (to show the stained areas on a lighter background) and each
image was converted to black and white so the images could be analyzed with the software.
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Then, each image was opened in Image J and the image type was converted into 8-bit (Image →
Type → 8-bit). Next, the image threshold was set to highlight the stained areas (Process →
Binary → Make Binary). The area of the plaque was selected for analysis and the particles were
counted (Analyze → Analyze Particles). The cell count was completed for each GFP and DAPI
sample image and recorded and the percent of apoptotic cells was calculated [(GFP cell count /
DAPI cell count)*100] and recorded.
The necrotic area and total plaque area were also analyzed on the TUNEL images using
Inage J. Each image was taken as a 14.16in.X10.67in (1360X1040 pixels) image at 50x
magnification. Each image was opened and first set to 8-bit and then to RGB color (Image →
Type → 8-bit / Image → Type → RGB color). The GFP and DAPI image for the specified
sample were then merged to a single combined composite image, maintaining the 1360X1040
pixel size (Make composite → Merge channels). The total plaque area was then selected and
measured (Analyze → Measure) in pixels and recorded. Next, the necrotic area (area lacking
both stains) was selected and measured (Analyze → Measure) in pixels and recorded. The
percent necrotic area was calculated [(necrotic area/total plaque area)*100] and recorded.
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Chapter 3 : Results
In order to test the hypothesis, we analyzed the percentage of collagen deposition and the
percentage of necrotic area within the plaque in the aortic roots of mice in the presence and
absence of Ron using trichrome collagen staining. Aortic root sections were also analyzed using
TUNEL assay to quantify the percentage of apoptotic cells in the plaques as well as the amount of
necrosis. All complete data tables referred to in the results can be viewed in the Appendix.

Trichrome Collagen Staining
The aortic roots stained for collagen presence were imaged under a microscope at 50x
magnification to observe the plaque area and specifically to allow us to analyze the collagen
deposition and the visible necrotic core. All sample pictures were taken as a 14.16in.X10.67in.
image containing 1360X1040 pixels, which was crucial to enable measurements of the areas as
we were unable to image the samples with a scale bar. This uniform imaging allowed us to
measure the area in in.2 of the image since there was known to be 96.012 pixels per inch. All
areas were measured using Image J software on images taken at the same magnification to ensure
standard measurements using these parameters. In Figure 1 you can see examples of aortic root
samples with the trichrome collagen stain for both the ApoE-/- and the ApoE-/-/Ron-/- (DKO)
genotypes. The images labeled (A) and (C) are the full stained sample image at 50x
magnification (not the picture size has been reduced to fit on the page) and (B) and (D) are the
isolation of the plaque visible in the aortic root used for Image J analysis of total area, collagen
area, and necrotic area.

DKO

ApoE KO
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400 µm

Figure 1: Trichrome Collagen Staining
(A) Trichrome collagen stained aortic root section from ApoE -/- mouse, full image at 50x
magnification. (B) Trichrome collagen stained aortic root section from ApoE -/- mouse,
isolated plaque image at 50x magnification used for Image J analysis. (C) Trichrome collagen
stained aortic root section from ApoE-/-/Ron-/- mouse, full image at 50x magnification.
(D) Trichrome collagen stained aortic root section from ApoE -/-/Ron-/- mouse, isolated plaque
image at 50x magnification used for Image J analysis.

Collagen Area
We studied the amount of collagen deposition in the plaque because previous studies
have suggested that thinning of the fibrous cap, which is composed of collagen, can contribute to
rupture of the plaque, causing hemorrhaging and death1. It was thought that mice with Ron may
show a greater deposition of collagen, thus suggesting it plays a protective role by lessening the
thinning of the fibrous cap. The percentage of plaque area stained for collagen was calculated by
taking the area of the collagen stain, dividing it by the total plaque area of the sample and
multiplying by 100. The average percent area for both genotypes of mice is shown in Figure 2
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below. The average percent collagen area for the ApoE-/- mice was 46.1%. The average percent
collagen area for the DKO mice was 48.2%. The error bars in Figure 2 are representative of 1
standard deviation from the average of percent collagen area.

Figure 2: Average Percent Collagen Area
This figure shows the average (mean) percent of atherosclerotic plaque area stained for
collagen presence using the trichrome collagen staining in the ApoE -/- and ApoE-/-/Ron-/(DKO) tissue samples. p = 0.78, n = 11,8. Data represent means +/-SD.

Table 1 includes the collagen area, the total area, and the percent area (collagen area/total
area) for each of the ApoE-/- mice samples using the analyze measurement tool on the Image J
software. Table 2 includes the collagen area, the total area, and the percent area for each of the
double knockout mice. A t-test was used to compare the percentage of plaque area stained for
collagen between the ApoE-/- tissue samples and the ApoE-/- / Ron-/- tissue samples and the pvalue was 0.78. For the ApoE-/- group n=11 and for the DKO group n=8. Since no difference
was found between the presence or absence of Ron in relation to collagen presence, Ron may not
protect against lesion rupture by way of affecting collagen presence in the plaques.
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Necrotic Area
Since Ron has been shown to promote development of M2 macrophages, those associated
with apoptotic cell clearance and wound repair, it was expected that mice with the Ron receptor
would have a less necrosis present in the forming lesions. A decrease in the amount of necrotic
area in the plaques of mice with Ron would support the hypothesis that Ron plays a protective
role in lesion progression. The necrotic area of the plaques was first analyzed using trichrome
collagen staining. The necrotic area was considered to be the non-collagen stained portion of the
identified plaque area, typically seen as a visible core area. The measured necrotic area and the
total plaque area as measured using Image J measurements are located in Table 3 and Table 4.
The percent necrotic area was calculated by dividing the necrotic area by the total plaque area and
multiplied by 100, also seen in Tables 3 and 4. Table 3 is the ApoE-/- tissue samples and Table 4
is the DKO tissue samples.
A t-test run to compare the ApoE-/- and DKO percent necrotic areas and showed a p-value
of 0.86. For the ApoE-/- group n=11 and for the DKO group n=8. Figure 3, below, displays the
average percent necrotic area for the ApoE-/- and DKO mice groups. The average percent
necrotic area for the ApoE-/- mice was 40.0% and the average area for the DKO mice was 38.8%.
The error bars present on the figure are representative of 1 standard deviation from the average
percentage of necrotic area. These calculations did not show a difference in the amount of
necrosis between the two genotypes, suggesting Ron did not affect the progression of this visible
necrotic core.
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Figure 3: Average Percent Necrotic Area on Collagen Stain
This figure shows the average (mean) necrotic area in the atherosclerotic plaque
measured on the trichrome collagen stain images in the ApoE -/- and ApoE-/-/Ron-/- (DKO)
tissue samples. p = 0.86, n =11,8. Data show means +/- SD.

TUNEL Assay
Next, we imaged aortic root samples from the TUNEL assay under 200x magnification
by fluorescence microscopy in order to study apoptotic cell presence in the plaques as well as
further study the extent of necrosis. Images were taken to view the green fluorescence protein
(GFP) stain, which labels DNA strand breaks to identify the apoptotic cells. It was also used to
view the DAPI stain (blue) which tags nuclei of all cells. Below, in Figure 4, you can see the GFP
and DAPI stain for both an ApoE-/- (A, B) and double knock out (C, D) samples. The outer edge
of the plaque is marked with the dashed line and the necrotic area is outlined and labeled “nec”
used for the second TUNEL analysis below.
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Figure 4: TUNEL Assay Images: GFP and DAPI
(A) GFP labeled aortic root section from ApoE -/- mouse to visualize apoptotic cells at 200x
magnification. (B) DAPI labeled aortic root section from ApoE -/- mouse to visualize cell nuclei at
200x magnification. (C) GFP labeled aortic root section from ApoE -/-/Ron-/- mouse at 200x
magnification. (D) DAPI labeled aortic root section from ApoE-/-/Ron-/- mouse at 200x
magnification. Apoptotic cell counts within the plaque area were taken from (A) and (C) using
Image J software. Total cell counts within the plaque area were taken from (B) and (D) using
Image J software. Outer edge of the plaque area is marked with a dashed line and the necrotic area
is outlined and labeled “nec” in all images.

TUNEL Assay Cell Counts
With the aim of seeing if the presence or absence of Ron influenced the amount of
apoptosis occurring in the lesions, the quantity of cells undergoing apoptosis in the plaques were
analyzed using TUNEL assay. It was first expected that there would be a larger portion of cells
in the samples lacking Ron. Using Image J software, the total number of cells undergoing
apoptosis (GFP) and the total number of cells (DAPI) within the plaque were counted and
recorded. The percentage of cells undergoing apoptosis within the lesion was found by taking the
number of apoptotic cells divided by the total number of cells and multiplying by 100. All of
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these data can be found in Table 5 and Table 6. Table 5 contains the cell counts from the ApoE-/tissue samples and Table 6 contains the date from the ApoE-/-/Ron-/- tissue samples.
In 3 of the samples, 1 from the ApoE-/- group and 2 from the DKO group, the number of
apoptotic cells counted (GFP) was above the total cell count (DAPI) by the Image J software.
Since it is not possible for more than 100% of the cells present in the lesion to be undergoing
apoptosis, these data were looked at with and without these samples in question. This error is
thought to be an issue between the imaging of the sample and the quantitative technique of the
software used for counting. In this case, two t-tests were run to analyze the data. The first was
run using all the percentages calculated, including three samples where the percentage was above
100%. For this run, n=18 for the ApoE-/- genotype and n=19 for the DKO genotype and the pvalue was 0.054.
Next, a t-test was run, eliminating the samples in question where the total percentage was
greater than 100%. The data used for this t-test can be viewed in Table 7 and Table 8. For this
run, n=17 for the ApoE-/- genotype and n=17 for the DKO genotype and the p-value was 0.017.
These data show a significantly greater amount of cells present in the lesions of mice with the
Ron receptor. This may suggest that Ron promotes apoptosis as a way to protect against lesion
progression in atherosclerosis.
For this data set, the average percentage of apoptotic cells for both genotypes was
calculated twice. The first was inclusive of the three samples in question, where the total
percentage was greater than 100 and the second was the average after eliminating these 3 data
points. Both averages can be seen in Figure 5 below. The error bars present on the figure are
representative of 1 standard deviation from the average apoptotic cell percentage.
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Figure 5: Percent Apoptotic Cells in Plaque Area
This figure displays the average (mean) percentage of cells undergoing apoptosis in the
plaque area in ApoE-/- and ApoE-/-/Ron-/- (DKO) tissue samples. The blue bars show the
average when 3 samples in question (calculated percentage over 100%) were included in
the calculation. The red bars show the average when the 3 samples in question were
excluded. The error bars represent 1 standard deviation from the mean. For the blue
bars, p=0.054, n=18,19. Data represent means +/-SD. For the red bars, p=0.017,
n=17,17. Data shows means +/-SD.

TUNEL Assay Necrotic Core
To better understand the progression of necrosis in the atherosclerotic plaques and to try
to gain a better understanding of the connection between apoptosis and necrotic area, necrotic
area of the plaques were measured on the TUNEL assay images. We expected necrosis to be
more advanced in tissue samples of mice lacking the Ron receptor, because is was hypothesized
that Ron plays a protective role in the advancement of atherosclerotic lesions. Also, possibly
identifying a connection between apoptosis and necrosis progression in the lesion may help up to
better understand the way in which Ron may act in this protective role. This measuring of the
necrotic core was done using the merged GFP/DAPI images for each sample. The necrotic area
was considered to be the area in the plaque where there were no apoptotic cells or cell nuclei
present, as can be seen outlined and labeled “nec” on the TUNEL assay images in Figure 4.

19
The samples were separated by genotype, ApoE-/- and DKO, where necrotic area and
total plaque area were measure using Image J measurement analysis and recorded in Table 9
(ApoE-/-) and Table 10 (DKO). The percentage necrotic area was calculated for each group by
dividing the necrotic area by the total plaque area and multiplying by 100. The percentages are
shown on Table 9 and Table 10. A t-test was run where n=18 for the ApoE-/- group and n=19 for
the ApoE-/-/Ron-/- group and the p-value was 0.063. The average percent necrotic area was
calculated for the ApoE-/- and DKO aortic root samples and are show below in Figure 6. The
average percent necrotic area for ApoE-/- tissue samples was 19.0% and the average for DKO
tissue samples was 24.5%. The error bars on Figure 6 express 1 standard deviation from the
average percent necrotic area.
The t-test indicated that there was no difference in the progression of necrosis in the
presence or absence of the Ron receptor. However, because the p-value was less than 0.1, it
suggests there may be a trend towards a greater amount of necrosis in samples from mice lacking
the Ron receptor. Increasing the sample size may reveal a difference in the amount of necrosis
between the genotypes. It may also be beneficial to study the amount of necrosis in younger mice
with less advanced lesions, to identify if there is a difference in amount of necrosis in earlier
lesions.
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Figure 6: Percent Necrotic Area from TUNEL
This figure shows the average (mean) necrotic area in the atherosclerotic plaque
measured on the TUNEL assay images in the ApoE-/- and ApoE-/-/Ron-/- (DKO) tissue
samples. p = 0.63, n = 18,19. Data represent means +/-SD.
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Chapter 4 : Discussion

The purpose of this research was to take a closer look at the composition of
atherosclerotic plaques in hopes of gaining a better understanding of the role the receptor tyrosine
kinase Ron plays in the progression of atherosclerosis. It is known that Ron is expressed in
subset of macrophages, and that it promotes the development of M2 macrophages and their
function in tissue repair and apoptotic cell clearance. Since the progression of atherosclerosis is
associated with an increase in M1 macrophages associated with proinflammatory processes and a
decrease in M2 macrophages associated with repair and cell clearance, it is thought the activity of
Ron may alter the balance of macrophage activation. In an attempt to better understand the
composition of the plaques we investigated the presence of collagen, necrotic areas, and the
presence of apoptotic cells in atherosclerotic plaques formed in mice predisposed to form lesions.
The first part of my studies used trichrome collagen staining of aortic root samples.
Tissue samples of single knock out (ApoE-/-) mice were compared with tissue samples of double
knock out (ApoE-/-/Ron-/-) mice with respect to possible changes in percent area of the plaque that
was positively stained for collagen. Unexpectedly, a t-test showed a p-value of 0.78, indicating
that the amount of collagen per area between the two groups was unaffected by the absence of
Ron. This suggests that Ron may not protect against lesion rupture with respect to thinning of the
fibrous cap, composed of collagen, which can lead to hemorrhaging and death.
The necrotic area of ApoE-/- and ApoE-/-/Ron-/- tissue samples were also compared using
trichrome collagen staining and measuring the area within a plaque that appeared to form a
visible core. As before, a t-test showed that there was no difference between genotypes and thus
that Ron did not affect the size of the necrotic area. Upon further review, it was thought that this
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method to measure a necrotic core was likely lacking in accuracy since a lack of collagen is not
the single requirement for an area within a plaque to be a necrotic core area. Using the TUNEL
stained samples was thought to be a more accurate way to identify necrotic areas within the
plaques.
While this collagen stain was not conclusive in determining more about how Ron affects
the composition of atherosclerotic plaques, it does not exclude the examination of collagen as an
important characteristic to understand in the progression of the disease. Additional methods of
sample staining or imaging could be beneficial for future studies of collagen deposition in
atherosclerotic plaques. A technique which may help provide a better view into the collagen
plaque composition is FT-IR spectroscopy. Studies have shown that this type of imaging and
histology can better characterize the biochemical composition of atherosclerotic plaques. It has
the potential to analyze the lipids, connective tissues, calcifications, and other cellular debris
contained in the plaque16. Upon gaining a better view of the complicated structural components
of atherosclerotic plaques, it may be possible to target more specific differences between mice
that have or lack the Ron receptor gene.
Next, atherosclerotic tissue samples were analyzed by TUNEL assay to assess possible
effects of Ron in apoptosis. The ApoE-/- single knock out group had a significantly higher
percentage of apoptotic cells present in the plaque area than the DKO group. In three samples the
calculated apoptotic cell percentage was greater than 100%. Since it is not possible to have
greater than 100% of cells undergoing apoptosis, this was thought to be an issue with the staining
or imaging of these samples, which then caused difficulty for the software when trying to analyze
and count the apoptotic cells and the cell nuclei. The data was included for both the complete
data set in which case the three samples in question were kept in the calculations as well as the
calculations when these three samples were excluded from the calculation. A t-test was run for
both of these data sets. When the three samples in question were included the p-value was 0.054.
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With these three samples excluded, the p-value was 0.017, which is considered to be a
statistically significant difference in the percentage of cells undergoing apoptosis between the
genotypes.
The finding that the group that has the Ron receptor gene has a greater percentage of
apoptotic cells in the total plaque area must be looked at alongside other data collected for the
samples. By itself, it may seem intuitive to think more apoptotic cell presence must indicate a
further progression of the plaque. However, this is not necessarily the case. In the progression of
atherosclerotic lesions, the cells in the plaque must die, but often remains of cellular debris
remain in the necrotic core, which is indicative of a more advanced lesion. In the case where the
cells in the plaque undergo apoptosis and cell clearance, there is less opportunity for necrosis to
take place. In this case, one would expect to see more apoptotic cells in a less advanced lesion
than in a more advanced lesion, and would be supported if it was also noted that the lesion
thought to be more advanced has a greater necrotic area, or total plaque area. To better
understand this, it is best to connect these conclusions to other images analyzed in the research.
The final portion of my research used the TUNEL assay images to measure the amount of
necrosis in the atherosclerotic lesions. The necrotic areas were identified as areas lacking cell
nuclei and apoptotic cells in merged GFP/DAPI stained images. The average percent necrotic
area of the plaque appeared to be greater in the samples lacking the Ron receptor, than in ApoE-/samples. However, comparing the necrotic areas between the sample groups using a t-test
showed that there was no difference. Although no difference was found, because the p-value
(0.063) was below 0.1, the results suggest a possible trend in the data. This may suggest a trend
towards greater necrotic area in mice lacking the Ron receptor. It is thought that a significant
difference may be seen if the sample size were to be increased. This is partially due to the large
standard deviation from the average percent necrotic area observed in both ApoE-/- and ApoE-//Ron-/- tissue samples. Taking this data into account with the previous data about the amount of
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apoptotic cells present in the plaque areas, it is thought that these results may provide support for
the hypothesis that Ron plays a protective role in the progression of atherosclerosis.
To conclude, atherosclerosis is one chronic inflammatory condition that is a very
prominent issue in the medical field today. The role of inflammation in atherosclerosis
progression, as well as other health problems such as hypertension and obesity, is still a very
active field of study. The hope is to advance our understanding of the complex nature of these
diseases, such that in the future we will be able to provide better therapies and solutions to the
issues facing those suffering today. By gaining a better understanding of how the composition of
the plaques in atherosclerosis progresses with respect to the Ron receptor tyrosine kinase, we will
hopefully be able to find better, more efficient ways to diagnose and treat these conditions.
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Appendix
Complete Data Tables
Table 1: Trichrome Collagen Stain: ApoE-/- Collagen Area
Sample
8/28/12 H8
9/17/12 H1
9/17/12 H13
9/26/12 H1
9/26/12 H2
2/19/13 H2
2/19/13 H3
2/19/13 H5
8/28/12 H7
8/28/12 H10
8/28/12 H11
Average

Collagen Area (in.2)
4.036
2.278
1.431
1.484
4.710
2.165
4.262
4.734
1.291
3.397
0.913
2.791

Total Area (in.2)
7.177
4.800
6.480
6.995
11.551
3.082
6.080
6.895
4.699
7.449
2.459
6.152

Percent Area (%)
56.2
47.5
22.1
21.2
40.8
70.2
70.1
68.7
27.5
45.6
37.1
46.1

The table below displays data collected from aortic root atherosclerotic plaques of ApoE-/- mice
stained with trichrome collagen stain imaged at 50x magnification. Collagen area and total plaque
area were measured through an Image J threshold measurement analysis process. The process
(described fully in methods) measured area of plaque positively stained for collagen followed by
total area of isolated plaque in the image. Figure 1 (B) shows an example of the isolated plaque
image used for analysis. Percent area was calculated for each of the 11 samples [(collagen
area/total area)*100].
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Table 2: Trichrome Collagen Stain: ApoE-/-/Ron-/- Collagen Area
Sample
8/28/12 H 16
9/26/12 H5
9/26/12 H6
9/26/12 H7
9/26/12 H9
2/19/13 H7
2/19/13 H9
8/28/12 H12
Average

Collagen Area (in2)
4.872
4.843
1.359
1.560
2.653
2.244
3.075
1.278
2.736

Total Area (in.2)
9.342
11.140
3.103
2.943
8.778
4.028
4.495
3.300
5.891

Percent Area (%)
52.2
43.5
43.8
53.0
30.2
55.7
68.4
38.7
48.2

The table below displays data collected from aortic root atherosclerotic plaques of ApoE-/-/Ron-/mice stained with trichrome collagen stain imaged at 50x magnification. Collagen area and total
plaque area were measured through an Image J threshold measurement analysis process. The
process (described fully in methods) measured area of plaque positively stained for collagen
followed by total area of isolated plaque in the image. Figure 1 (D) shows an example of the
isolated plaque image used for analysis. Percent area was calculated for each of the 8 samples
[(collagen area/total area)*100].
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Table 3: Trichrome Collagen Stain: ApoE-/- Necrotic Area
Sample
8/28/12 H8
9/17/12 H1
9/17/12 H13
9/26/12 H1
9/26/12 H2
2/19/13 H2
2/19/13 H3
2/19/13 H5
8/28/12 H7
8/28/12 H10
8/28/12 H11
Average

Necrotic Area (in.2)
2.208
1.679
4.008
4.090
5.242
0.636
1.262
1.367
2.439
2.828
1.402
2.469

Total Area (in.2)
7.177
4.800
6.480
6.995
11.551
3.082
6.080
6.895
4.699
7.449
2.459
6.152

Percent Area (%)
30.8
35.0
61.9
58.5
45.4
20.6
20.8
19.8
51.9
38.0
57.0
40.0

This table displays data collected from aortic root atherosclerotic plaques of ApoE -/- mice stained
with trichrome collagen stain imaged at 50x magnification. Necrotic area and total plaque area
were measured through an Image J measurement analysis process. The process (described fully in
methods) measured the area of the outlined necrotic area. The total plaque area of the samples
was measure previously as listed in the collagen area data tables and was again used for this
analysis. Figure 1 (B) shows an example of the isolated plaque image used for analysis. Percent
area was calculated for each of the 11 samples [(necrotic area/total area)*100].
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Table 4: Trichrome Collagen Stain: ApoE-/-/Ron-/- Necrotic Area
Sample
8/28/12 H 16
9/26/12 H5
9/26/12 H6
9/26/12 H7
9/26/12 H9
2/19/13 H7
2/19/13 H9
8/28/12 H12
Average

Necrotic Area (in.2)
3.150
4.709
1.430
1.095
4.947
1.114
1.000
1.475
2.365

Total Area (in.2)
9.342
11.140
3.103
2.943
8.778
4.028
4.495
3.300
5.891

Percent Area (%)
33.7
42.3
46.1
37.2
56.4
27.7
22.2
44.7
38.8

This table displays data collected from aortic root atherosclerotic plaques of ApoE -/-/Ron-/- mice
stained with trichrome collagen stain imaged at 50x magnification. Necrotic area and total plaque
area were measured through an Image J measurement analysis process. The process (described
fully in methods) measured the area of the outlined necrotic area. The total plaque area of the
samples was measure previously as listed in the collagen area data tables and was again used for
this analysis. Figure 1 (D) shows an example of the isolated plaque image used for analysis.
Percent area was calculated for each of the 8 samples [(necrotic area/total area)*100].
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Table 5: TUNEL Cell Counts: ApoE-/Sample

Total Cells
(DAPI)
84

Percentage (%)

3/26/2012 H1 - 1

Apoptotic Cells
(GFP)
76

3/26/2012 H1 - 2

113

200

56.5

3/26/2012 H1 - 3

89

154

57.8

8/28/12 H8 - 1

154

264

58.3

8/28/12 H8 - 2

310

339

91.4

8/28/12 H8 - 3

65

168

38.7

8/28/12 H10 - 1

163

166

98.2

8/28/12 H10 - 2

54

117

46.2

8/28/12 H10 - 3

99

100

99.0

9/17/12 H1 - 1

209

189

110.6

9/17/12 H1 - 2

182

222

82.0

9/17/12 H1 - 3

112

160

70.0

9/26/12 H1 - 1

203

317

64.0

9/26/12 H1 - 2

121

172

70.3

9/26/12 H1 - 3

38

43

88.4

9/26/12 H2 - 1

150

256

58.6

9/26/12 H2 - 2

119

133

89.5

9/26/12 H2 - 3

177

314

56.4

135.22

188.78

73.7

Average

90.5

This table below displays TUNEL assay data collected from aortic root atherosclerotic plaques of
ApoE-/- mice. The number of apoptotic cells (labeled with GFP) in the atherosclerotic plaque area
were quantified using Image J software. The total number of cells present in the plaque area
(nuclei labeled with DAPI) was also quantified using Image J. The percentage of cells undergoing
apoptosis was calculated for each of the 18 samples [(apoptotic cells/total cells)*100]. The 18
samples were 18 different plaque regions imaged on 6 different aortic root samples at 200x
magnification. The 9/17/12 H1 – 1 sample showed a calculated percentage over 100%, which is
not possible as a percentage of total cells in the plaque, and was thus excluded from calculation as
shown in Table 7.
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Table 6: TUNEL Cell Counts: ApoE-/-/Ron-/Sample

Total Cells
(DAPI)
203

Percentage (%)

9/26/13 H5 - 1

Apoptotic
Cells (GFP)
155

9/26/13 H5 - 2

333

295

112.9

9/26/13 H5 - 3

124

182

68.1

3/26/12 H6 - 1

82

218

37.6

3/26/12 H6 - 2

50

302

16.6

3/26/12 H6 - 3
3/26/12 H7 - 1

88
57

63
140

139.7
40.7

3/26/12 H7 - 2

62

85

72.9

3/26/12 H7 - 3

15

61

24.6

3/26/12 H8 - 1

16

108

14.8

3/26/12 H8 - 2

30

109

27.5

3/26/12 H8 - 3

18

169

10.7

8/28/12 H16 - 1

104

109

95.4

8/28/12 H16 - 2

33

150

22.0

8/28/12 H16 - 3

12

186

6.5

3/26/12 H9 - 1

101

139

72.7

3/26/12 H9 - 2

236

242

97.5

3/26/12 H9 - 3

52

299

17.4

3/26/12 H9 - 4

68

124

54.8

86.11

167.58

53.1

Average

76.4

This table below displays TUNEL assay data collected from aortic root atherosclerotic plaques of
ApoE-/-/Ron-/- mice. The number of apoptotic cells (labeled with GFP) in the atherosclerotic
plaque area were quantified using Image J software. The total number of cells present in the
plaque area (nuclei labeled with DAPI) was also quantified using Image J. The percentage of cells
undergoing apoptosis was calculated for each of the 19 samples [(apoptotic cells/total cells)*100].
The 19 samples were 19 different plaque regions imaged on 6 different aortic root samples at 200x
magnification. The 9/26/12 H5 – 2 and the 3/26/12 H6 -3 samples showed a calculated percentage
over 100%, which is not possible as a percentage of total cells in the plaque undergoing apoptosis,
and was thus excluded from calculation as shown in Table 8.
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Table 7: TUNEL Cell Counts (>100% removed): ApoE-/Sample
3/26/2012 H1 – 1
3/26/2012 H1 – 2
3/26/2012 H1 – 3
8/28/12 H8 – 1
8/28/12 H8 – 2
8/28/12 H8 – 3
8/28/12 H10 – 1
8/28/12 H10 – 2
8/28/12 H10 – 3
9/17/12 H1 – 2
9/17/12 H1 – 3
9/26/12 H1 – 1
9/26/12 H1 – 2
9/26/12 H1 – 3
9/26/12 H2 – 1
9/26/12 H2 – 2
9/26/12 H2 – 3
Average

Apoptotic Cells
(GFP)
76
113
89
154
310
65
163
54
99
182
112
203
121
38
150
119
177
130.88

Total Cells
(DAPI)
84
200
154
264
339
168
166
117
100
222
160
317
172
43
256
133
314
188.76

Percentage (%)
90.5
56.5
57.8
58.3
91.4
38.7
98.2
46.2
99.0
82.0
70.0
64.0
70.3
88.4
58.6
89.5
56.4
71.5

The table below displays TUNEL assay data collected from aortic root atherosclerotic plaques of
ApoE-/- mice. The number of apoptotic cells (labeled with GFP) in the atherosclerotic plaque area
were quantified using Image J software. The total number of cells present in the plaque area
(nuclei labeled with DAPI) was also quantified using Image J. The percentage of cells undergoing
apoptosis was calculated for each of the 17 samples [(apoptotic cells/total cells)*100]. The 1
samples were 17 different plaque regions imaged on 6 different aortic root samples at 200x
magnification. A single sample in question, that had a calculated percentage greater than 100%,
was excluded from the table and calculations.
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Table 8: TUNEL Cell Counts (>100% removed): ApoE-/-/Ron-/Sample

Total Cells
(DAPI)
203

Percentage (%)

9/26/13 H5 - 1

Apoptotic Cells
(GFP)
155

9/26/13 H5 - 3

124

182

68.1

3/26/12 H6 - 1

82

218

37.6

3/26/12 H6 - 2

50

302

16.6

3/26/12 H7 - 1

57

140

40.7

3/26/12 H7 - 2

62

85

72.9

3/26/12 H7 - 3

15

61

24.6

3/26/12 H8 - 1

16

108

14.8

3/26/12 H8 - 2

30

109

27.5

3/26/12 H8 - 3

18

169

10.7

8/28/12 H16 - 1

104

109

95.4

8/28/12 H16 - 2

33

150

22.0

8/28/12 H16 - 3

12

186

6.5

3/26/12 H9 - 1

101

139

72.7

3/26/12 H9 - 2

236

242

97.5

3/26/12 H9 - 3

52

299

17.4

3/26/12 H9 - 4

68

124

54.8

71.47

166.24

44.5

Average

76.4

This table displays TUNEL assay data collected from aortic root atherosclerotic plaques of ApoE-//Ron-/- mice. The number of apoptotic cells (labeled with GFP) in the atherosclerotic plaque area
were quantified using Image J software. The total number of cells present in the plaque area
(nuclei labeled with DAPI) was also quantified using Image J. The percentage of cells undergoing
apoptosis was calculated for each of the 17 samples [(apoptotic cells/total cells)*100]. The 17
samples were 17 different plaque regions imaged on 6 different aortic root samples at 200x
magnification. Two samples in question were excluded from the table and further calculations
because the calculated percentage of apoptotic cells was greater than 100%, which is not possible.
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Table 9: TUNEL Necrotic Area: ApoE-/Sample

Total Area
(pixels)
341483

Percentage (%)

3/26/2012 H1 - 1

Necrotic Area
(pixels)
145023

3/26/2012 H1 - 2

96292

488096

19.7

3/26/2012 H1 - 3

89377

398692

22.4

8/28/12 H8 - 1

79543

646198

12.3

8/28/12 H8 - 2

77240

703641

11.0

8/28/12 H8 - 3

87587

551718

15.9

8/28/12 H10 - 1

53198

452725

11.8

8/28/12 H10 - 2

63970

307493

20.8

8/28/12 H10 - 3

45822

281517

16.3

9/17/12 H1 - 1

234183

852278

27.5

9/17/12 H1 - 2

150556

586637

25.7

9/17/12 H1 - 3

145754

506193

28.8

9/26/12 H1 - 1

76844

663974

11.6

9/26/12 H1 - 2

80805

507329

15.9

9/26/12 H1 - 3

103537

352996

29.3

9/26/12 H2 - 1

23809

475803

5.0

9/26/12 H2 - 2

28539

342200

8.3

9/26/12 H2 - 3

151563

882820

17.2

96313.44

518988.50

19.0

Average

42.5

This table below displays TUNEL assay image data collected from aortic root atherosclerotic
plaques of ApoE-/- mice imaged at 200x magnification as a 1360X1040 pixels image. Necrotic
area and total plaque area were measured in number of pixels. This process (described fully in
methods) measured the area of the outlined necrotic area followed by the outlined total plaque area
on merged GFP/DAPI images. Figure 4 (A) (B) shows examples of the GFP/DAPI images used
for analysis with the outlined necrotic area. Percent area was calculated for each of the 18 samples
[(necrotic area/total area)*100]. The 18 samples were 18 different plaque regions of 6 different
tissue samples.
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Table 10: TUNEL Necrotic Area: ApoE-/-/Ron-/Sample
9/26/13 H5 - 1
9/26/13 H5 - 2
9/26/13 H5 - 3
3/26/12 H6 - 1
3/26/12 H6 - 2
3/26/12 H6 - 3
3/26/12 H7 - 1
3/26/12 H7 - 2
3/26/12 H7 - 3
3/26/12 H8 - 1
3/26/12 H8 - 2
3/26/12 H8 - 3
8/28/12 H16 - 1
8/28/12 H16 - 2
8/28/12 H16 - 3
3/26/12 H9 - 1
3/26/12 H9 - 2
3/26/12 H9 - 3
3/26/12 H9 - 4
Average

Necrotic Area
(pixels)
111535
59009
140071
97274
185298
188429
209855
265497
105304
70765
209311
127266
161101
85053
120608
52672
97752
115315
85325
130917.89

Total Area
(pixels)
553968
455106
548064
521350
734399
466635
723914
717604
320523
346132
563190
518524
521595
405810
513431
368591
630081
755156
411549
530295.89

Percentage (%)
20.1
13.0
25.6
18.7
25.2
40.4
29.0
37.0
32.9
20.4
37.2
24.5
30.9
21.0
23.5
14.3
15.5
15.3
20.7
24.5

This table shows TUNEL assay image data collected from aortic root atherosclerotic plaques of
ApoE-/-/Ron-/- mice imaged at 200x magnification as a 1360X1040 pixels image. Necrotic area
and total plaque area were measured in number of pixels. This process (described fully in
methods) measured the area of the outlined necrotic area followed by the outlined total plaque area
on merged GFP/DAPI images. Figure 4 (C) (D) shows examples of the GFP/DAPI images used
for analysis with the outlined necrotic area. Percent area was calculated for each of the 19 samples
[(necrotic area/total area)*100]. The 19 samples were 19 different plaque regions of 6 different
tissue samples.
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